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RZ/T2M, RZ/T2ME, RZ/N2L, RZ/T2L Group 
Quick Start Guide: lwIP Protocol Stack Sample Program 
Introduction 
This document describes the setup procedure of the sample program that implements lwIP (lightweight IP) 
protocol stack on the Renesas RZ/T2M, RZ/T2ME, RZ/N2L, RZ/T2L platform.  
 

Target Device 
RZ/T2M, RZ/T2ME, RZ/N2L, RZ/T2L 
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1. Overview 
This document describes the setup procedure of the sample program for RZ/T2M, RZ/T2ME, RZ/N2L, 
RZ/T2L of Industrial Network 

Please note that since RZ/T2ME can run using RZ/T2M project files, we will omit the specific description for 
RZ/T2ME. 

1.1 Abbreviations / Definitions 
Table 1.1. Abbreviations/Definitions 

Index Abbreviations 
/Definitions Description 

1 IP Internet Protocol 
2 TCP Transmission Control Protocol 
3 USB Universal Serial Bus 
4 PC Personal Computer 
5 SW Switch 
6 EWARM Embedded Workbench® for ARM 
7 lwIP lightweight IP 

 

1.2 Reference 
Technical information about RZ/T2M, RZ/N2L, RZ/T2L is available via Renesas. 

Table 1.2 Technical Inputs for RZ/T2M 

Document 
Type 

Description  Document Tile Document No.  

User's 
Manual 

Describes the technical details 
of the RSK+RZT2M hardware. 

Renesas Starter Kit+ for 
RZ/T2M,RZ/T2ME  User’s Manual 

r20ut4939ej**** 

User's 
Manual 

Provides technical details of the 
RZ/T2M microprocessor. 

RZ/T2M Group User's Manual Hardware r01uh0916ej**** 

 

Table 1.3 Technical Inputs for RZ/N2L 

Document 
Type 

Description  Document Tile Document No.  

User's 
Manual 

Describes the technical details 
of the RSK+RZN2L hardware. 

Renesas Starter Kit+ for RZ/N2L User’s 
Manual 

r20ut4984ej**** 

User's 
Manual 

Provides technical details of the 
RZ/N2L microprocessor. 

RZ/N2L Group User's Manual Hardware r01uh0955ej**** 

 
Table 1.4 Technical Inputs for RZ/T2L 

 

1.3 Limitation / Known Issue 
None  

Document 
Type 

Description  Document Tile Document No.  

User's 
Manual 

Describes the technical details 
of the RSK+RZT2L hardware. 

Renesas Starter Kit+ for RZ/T2L User’s 
Manual 

r20ut5164ej**** 

User's 
Manual 

Provides technical details of the 
RZ/T2L microprocessor. 

RZ/T2L Group User's Manual Hardware r01uh0985ej**** 

https://www.renesas.com/ja/document/mat/renesas-starter-kit-rzt2m-rzt2me-users-manual?language=en
https://www.renesas.com/en/document/mah/rzt2m-group-users-manual-hardware?language=jp&r=1611101
https://www.renesas.com/ja/document/mat/renesas-starter-kit-rzn2l-users-manual?language=en
https://www.renesas.com/en/document/mah/rzn2l-group-users-manual-hardware?language=en&r=1623406
https://www.renesas.com/ja/document/mat/renesas-starter-kit-rzt2l-users-manual?language=en
https://www.renesas.com/en/document/mah/rzt2l-group-users-manual-hardware?language=jp&r=25413951
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2. Features 
lwIP (lightweight IP) is an open-source embedded TCP/IP protocol stack. lwIP can implement full-scale TCP 
functionality with few resources and is suitable for use in embedded systems. lwIP was originally developed 
by Adam Dunkels at the Swedish Institute of Computer Science (SICS), It is now developed and maintained 
by a worldwide network of developers. For information on licensing lwIP, see "\common\oss\lwip\COPYING" 
in the sample program. 

2.1 Package folder structure 
Here is a folder overview of the main files: 
Please refer to the release notes for the folder tree. 
 
Table 2.1. Folder structure  

Folder name Overview 
common/oss lwip+freeRTOS package file 
common/renesas/application Applications 
common/renesas/module/ether_netif Ethernet API 
common/renesas/module/lwip_port lwip API 
common/renesas/module/serial_io Serial API for log output 
SRC Entry functions, etc. 
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3. Requirements (Software&Hardware) 
This project was developed and tested in an environment using the following boards and tools: 
 
3.1 RZ/T2M 
Table 3.1. RZ/T2M environment 

Category Name Version Description 
Board Renesas Starter Kit+ for 

RZ/T2M, RZ/T2ME 
User's Manual 
2.00 

Renesas 
RZ/T2M-RSK - Renesas 
Starter Kit Plus for 
RZ/T2M | Renesas 

IDE EWARM 9.60.3 IAR Systems 
IAR Embedded 
Workbench for Arm | 
IAR 

e2 studio 2025-12 RZ FSP 
About Flexible Software 
Package (FSP) for 
Renesas RZ series 

Configurator FSP Smart Configurator 2025-12 
Flexible Software 
Package  

FSP 4.0.0 

GCC Compiler  GNU ARM Embedded 
Toolchain 

13.3.Rel1 

GNU ARM A-Profile 
(AArch64 bare-metal) 

― 

Emulator  J-Link TM 8.60 SEGGER 
SEGGER - The 
Embedded Experts - 
Downloads - J-Link / J-
Trace 

I-jet  IAR Systems 
IAR debug probes | IAR 

Tera Term  Tera Term 
Tera Term Open Source 
Project 

Software  Wire shark  WIRESHARK 
Wireshark • Go Deep | 
Download 

 
  

https://www.renesas.com/en/design-resources/boards-kits/rz-t2m-rsk?queryID=038938d2a1728819185f796d55e6a770
https://www.renesas.com/en/design-resources/boards-kits/rz-t2m-rsk?queryID=038938d2a1728819185f796d55e6a770
https://www.renesas.com/en/design-resources/boards-kits/rz-t2m-rsk?queryID=038938d2a1728819185f796d55e6a770
https://www.iar.com/ja/products/architectures/arm/iar-embedded-workbench-for-arm/
https://www.iar.com/ja/products/architectures/arm/iar-embedded-workbench-for-arm/
https://www.iar.com/ja/products/architectures/arm/iar-embedded-workbench-for-arm/
https://www.segger.com/downloads/jlink
https://www.segger.com/downloads/jlink
https://www.segger.com/downloads/jlink
https://www.segger.com/downloads/jlink
https://www.iar.com/embedded-development-tools/iar-debug-probes
https://teratermproject.github.io/
https://teratermproject.github.io/
https://www.wireshark.org/download.html
https://www.wireshark.org/download.html
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3.2 RZ/N2L 
Table 3.2. RZ/N2L environment 

Category Name Version Description 
Board Renesas Starter Kit+ for 

RZ/N2L 
User's Manual 
1.04 

Renesas 

RZ/N2L-RSK - Renesas 
Starter Kit+ for RZ/N2L | 
Renesas 

IDE EWARM 9.60.3 IAR Systems 
IAR Embedded 
Workbench for Arm | 
IAR 

e2 studio 2025-12 RZ FSP 
About Flexible Software 
Package (FSP) for 
Renesas RZ series 

Configurator FSP Smart Configurator 2025-12 
Flexible Software 
Package  

FSP 4.0.0 

GCC Compiler  GNU ARM Embedded 
Toolchain 

13.3.Rel1 

GNU ARM A-Profile 
(AArch64 bare-metal) 

― 

Emulator  J-Link TM 8.60 SEGGER 
SEGGER - The 
Embedded Experts - 
Downloads - J-Link / J-
Trace 

I-jet  IAR Systems 
IAR debug probes | IAR 

Tera Term  Tera Term 
Tera Term Open Source 
Project 

Software  Wire shark  WIRESHARK 
Wireshark • Go Deep | 
Download 

 
  

https://www.renesas.com/en/design-resources/boards-kits/rz-n2l-rsk?srsltid=AfmBOor2eBzyqfFP6dAGHam0YOquHtFTxrGO1renpy4Ssox6or8tmrve
https://www.renesas.com/en/design-resources/boards-kits/rz-n2l-rsk?srsltid=AfmBOor2eBzyqfFP6dAGHam0YOquHtFTxrGO1renpy4Ssox6or8tmrve
https://www.renesas.com/en/design-resources/boards-kits/rz-n2l-rsk?srsltid=AfmBOor2eBzyqfFP6dAGHam0YOquHtFTxrGO1renpy4Ssox6or8tmrve
https://www.iar.com/ja/products/architectures/arm/iar-embedded-workbench-for-arm/
https://www.iar.com/ja/products/architectures/arm/iar-embedded-workbench-for-arm/
https://www.iar.com/ja/products/architectures/arm/iar-embedded-workbench-for-arm/
https://www.segger.com/downloads/jlink
https://www.segger.com/downloads/jlink
https://www.segger.com/downloads/jlink
https://www.segger.com/downloads/jlink
https://www.iar.com/embedded-development-tools/iar-debug-probes
https://teratermproject.github.io/
https://teratermproject.github.io/
https://www.wireshark.org/download.html
https://www.wireshark.org/download.html
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3.3 RZ/T2L 
Table 3.3. RZ/T2L environment 

Category Name Version Description 
Board Renesas Starter Kit+ for 

RZ/T2L 
User's Manual 
1.21 

Renesas 
RZ/T2L-RSK - Renesas 
Starter Kit+ for RZ/T2L | 
Renesas 

IDE EWARM 9.60.3 IAR Systems 
IAR Embedded 
Workbench for Arm | 
IAR 

e2 studio 2025-12 RZ FSP 
About Flexible Software 
Package (FSP) for 
Renesas RZ series 

Configurator FSP Smart Configurator 2025-12 
Flexible Software 
Package  

FSP 4.0.0 

GCC Compiler  GNU ARM Embedded 
Toolchain 

13.3.Rel1 

GNU ARM A-Profile 
(AArch64 bare-metal) 

― 

Emulator  J-Link TM 8.60 SEGGER 
SEGGER - The 
Embedded Experts - 
Downloads - J-Link / J-
Trace 

I-jet  IAR Systems 
IAR debug probes | IAR 

Tera Term  Tera Term 
Tera Term Open Source 
Project 

Software  Wire shark  WIRESHARK 
Wireshark • Go Deep | 
Download 

  

https://www.renesas.com/en/design-resources/boards-kits/rz-t2l-rsk?srsltid=AfmBOoplg4pEe-88iEeIp0HVVS3DXSOYSKLqrac8Rdbj4zcqktL-gMbP
https://www.renesas.com/en/design-resources/boards-kits/rz-t2l-rsk?srsltid=AfmBOoplg4pEe-88iEeIp0HVVS3DXSOYSKLqrac8Rdbj4zcqktL-gMbP
https://www.renesas.com/en/design-resources/boards-kits/rz-t2l-rsk?srsltid=AfmBOoplg4pEe-88iEeIp0HVVS3DXSOYSKLqrac8Rdbj4zcqktL-gMbP
https://www.iar.com/ja/products/architectures/arm/iar-embedded-workbench-for-arm/
https://www.iar.com/ja/products/architectures/arm/iar-embedded-workbench-for-arm/
https://www.iar.com/ja/products/architectures/arm/iar-embedded-workbench-for-arm/
https://www.segger.com/downloads/jlink
https://www.segger.com/downloads/jlink
https://www.segger.com/downloads/jlink
https://www.segger.com/downloads/jlink
https://www.iar.com/embedded-development-tools/iar-debug-probes
https://teratermproject.github.io/
https://teratermproject.github.io/
https://www.wireshark.org/download.html
https://www.wireshark.org/download.html
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4. Hardware Setup 
This section explains the main hardware. For details about the board you are using, please refer to the user's 
manual. 

4.1 RZ/T2M RSK Board 

 

Figure 4.1 RZ/T2M RSK board layout 
 

1. DIP SW and Jumper SW settings 

This is the initial setting in "6. Configuration" of the Renesas Starter Kit+ for RZ/T2M User's Manual. 

2. Connect the J-Link to micro USB or J20 with I-jet, switching between them using J9. 

3. Use a USB cable (Type-C) or an AC/DC adapter to supply power. 

- When using a USB cable, connect it to CN5. 

- When using an AC/DC adapter, connect it to CN6. 

4. Connect the Ethernet cable to ETH0, ETH1, or ETH2. 
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4.2 RZ/N2L RSK Board 

 

Figure 4.2 RZ/N2L RSK board layout 
 

1. DIP Switch and Jumper Switch Settings 

This setting is described in "6. Configuration" in the Renesas Starter Kit+ for RZ/T2L User's Manual. 

2. Connect the J-Link to micro USB or J20 with I-jet, switching between them using J9. 

3. Use a USB cable (Type-C) or an AC/DC adapter to supply power. 

- When using a USB cable, connect it to CN5. 

- When using an AC/DC adapter, connect it to CN6. 

4. Connect the Ethernet cable to ETH0, ETH1, or ETH2. 
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4.3 RZ/T2L RSK Board 

 

Figure 4.3 RZ/T2L RSK board layout 
 
1. DIP Switch and Jumper Switch Settings 

This setting is described in "6. Configurations" in the Renesas Starter Kit+ for RZ/T2L User's Manual. 

2. Connect the J-Link to micro USB or J20 with I-jet, switching between them using J9. 

3. Use a USB cable (Type-C) or an AC/DC adapter to supply power. 

- When using a USB cable, connect it to CN5. 

- When using an AC/DC adapter, connect it to CN6. 

4. Connect the Ethernet cable to ETH2. 
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4.4 Connecting the Debugger 
Connect the evaluation board and debugger according to the tool you are using. 
 

 
Figure 4. 4  Debugger Connection 

 
 
 
 
  

USB cable (J-Link) when 
using e2s 

USB and connector cable 
when using EWARM 

I-jet probe 
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5. Host PC Settings  
See "7. Demonstration of the Sample Application”  
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6. Running the Sample Application 
To run an EWARM project, proceed to 6.2. Setting Up the EWARM Sample Project. 

 

6.1 Setting Up the e² studio Sample Project 
6.1.1 Starting e² studio 

1. Open e² studio and select the workspace directory. 

2. Click "Open Projects from File System…" on the File tab. 

 

 

Figure 6.1 e²studio File tab 
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3. Import the project folder. 

➤ RZ/T2M 
Import the following two projects. 
 The following project has no functionality other than blinking the LED. 

Project Name: RZT2M_RSK_lwIP_cpu0 (hereafter referred to as "CPU0") 
Folder：project\rzt2m_rsk\e2studio\RZT2M_RSK_lwIP_cpu0  

 The following project includes functionality related to "7. Sample Application Demonstration." 
Project Name: RZT2M_RSK_lwIP_cpu1 (hereafter referred to as "CPU1") 
Folder: project\rzt2m_rsk\e2studio\RZT2M_RSK_lwIP_cpu1 

➤ RZ/N2L 
  Project Name: RZN2L_RSK_lwIP_single (hereafter referred to as "CPU0") 

Folder：project\rzn2l_rsk\e2studio 

➤ RZ/T2L 
  Project Name: RZT2L_RSK_lwIP_single (hereafter referred to as "CPU0")  

Folder：project\rzt2l_rsk\e2studio 
 

 

 
Figure 6.2 Import project on e²studio 
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6.1.2 Board IP address setting 
Set the IP address in the following procedure.  

1. The IP address is set in src/renesas/application/lwip_port_instance.c. 

The port number is set in src/renesas/application/lwip_port_main.c. 

The following addresses are used in the example: 

IP address  : 192.168.10.170 

Subnet mask : 255.255.255.065 

Default gateway : 192.168.10.1 

Port number : 65000 

 

 
Figure 6.3 Static IP address 

 

 
Figure 6.4 Port number 
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6.1.3 How to generate source code and how to build 
If there is a script folder in the Project Explorer window before code generation, the following precautions 
are required. 

 If you use anything other than the “ld” file in the folder, unexpected results may occur. 

 If you change the boot mode or FSP version, the “ld” file will be rewritten at the time of code 
generation, so please save it in advance and restore it to the script before building.  

If there is no change, there is no rewriting. 

 

1. Click the “Configuration.xml”. 

 

Figure 6.5 Configuration 
 

2. On the "FSP Smart Configurator" screen that appears, check the following settings in the "BSP" tab 
and click "Generate Project Content". The generated folder will be added to your workspace. 

For RZ/T2M, always start with CPU0.doku 

 

・RAM boot (RAM execution without flash memory) 
➢ RZ/T2M 

CPU0 and CPU1 have the same settings. 
・Board：:  RSK+RZT2M (RAM execution without flash memory) 

 
➢ RZ/N2L 

・Board：:  RSK+RZN2L (RAM execution without flash memory) 
 

➢ RZ/T2L 
・Board：:  RSK+RZT2L (RAM execution without flash memory) 
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Figure 6.6 Generate Project Conten 

 

Figure 6.7 Generate project folder 
 

3. Click the Build button in tool bar to build the project and confirm that there is no error message in build 
message log. 

For RZ/T2M, always start with CPU0. 
 

 
Figure 6.8 Build button 
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Figure 6.9 Build message 
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6.1.4 Downloading the application and running the debugger 
Please follow these steps for each project. 

1. Focus on the CPU0 project and click the Debug button on the toolbar to download the CPU0 program 
and launch the debugger. 

 
 

 
Figure 6.10 CPU0 Debug button 

 
2. Dialog response 

When starting the debugger, if a dialog other than an error display appears depending on the usage 
environment, select "Switch", "Yes", "OK", etc. to close it. 

 
3. The program will stop at the breakpoint set at startup, so simply click the Run button on the toolbar. 

For RZ/T2M, continue with CPU1. 
Before running, connect your PC as described in "7. Sample Application Demonstration." 

 
 

 
Figure 6.11 CPU0 Run button 
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4. Next, focus on the CPU1 project and click the Debug button on the toolbar to download the CPU1 
program and launch the debugger. 
At that time, the following dialog box will appear, so please click "No". 

 

 
Figure 6.12 CPU1 Debug button 

 

 
 

Figure 6.13 CPU1 Duplicate confirmation 
 

5. Other Dialogs 
If a dialog other than an error message appears due to your environment or other reasons, close it by 
selecting "Switch," "Yes," or "OK." 

 
6. The program will stop at the breakpoint set at startup, so simply click the Run button on the toolbar. 

 
Figure 6.14 CPU1 Run button 
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6.2 Setting Up the EWARM Sample Project 
For each of the project files listed below, please perform steps 1 through 3 below. 

6.2.1 Starting EWARM 
1. Open the EWARM. 

2. Click “Open Workspace…” in File tab. 

 

 
Figure 6.15 EWARM file tab 

 
3. Select the Workspace File(.eww) and click the Open button. 

➤ RZ/T2M 
Open the following two projects in separate EWARMs. 
・ The following project has no functionality other than blinking the LED. 

Project file: RZT2M_RSK_lwIP_cpu0.eww (hereafter referred to as "CPU0") 
Folder: project\rzt2m_rsk\ewarm\RZT2M_RSK_lwIP_cpu0 

・ The following project includes functionality related to "7. Demonstration of the Sample 
Application" 
Project file: RZT2M_RSK_lwIP_cpu1.eww (hereafter referred to as "CPU1") 
Folder: project\rzt2m_rsk\ewarm\RZT2M_RSK_lwIP_cpu1 

➤ RZ/N2L 
  Project file: RZN2L_RSK_lwIP_single.eww (hereafter referred to as "CPU0") 

Import the folder: project\rzn2l_rsk\ewarm. 

➤ RZ/T2L 
  Project file: RZT2L_RSK_lwIP_single.eww (hereafter referred to as "CPU0") 

Import the folder: project\rzt2l_rsk\ewarm. 
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6.2.2 Board IP address setting 
Set the IP address on the following procedure.  

The default settings are "192.168.10.1" for the host PC and "192.168.10.170" for the device. 

1. The IP address is set in \common\renesas\application\lwip_port_instance.c. 

The port number is set in \common\renesas\application\lwip_port_main.c. 

The following addresses are used in the example: 

IP address  : 192.168.10.170 

Subnet mask : 255.255.255.0 

Default gateway : 192.168.10.1 

Port number : 65000 

 

 

Figure 6.16 Static IP address 
 

 
Figure 6.17 Port number 
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6.2.3 How to generate source code and how to build 
1. Notes on Code Generation. 

・  Using an icf file other than the one in the script folder may result in unexpected results. 

・ If you change the boot mode or FSP version, the icf file will be rewritten during code 
generation. Therefore, save it beforehand and restore it to the previously saved icf file before 
building. If there are no changes, the file will not be rewritten. 

・ For RZ/T2M, build projects for CPU0 and CPU1. 

・ For RZ/T2M, do not open two "FSP Smart Configurator" projects simultaneously. 

・ If you installed "FSP Smart Configurator" in a location other than the default installation path, 
open the "buildinfo.ipcf" file in the project folder and edit the path set in RASC_EXE_PATH to 
match the actual location of rasc.exe. 

If you modify "buildinfo.ipcf," restart EWARM to reflect the changes. 

・ Click "FSP Smart Configurator" in the Tools tab. 
If you have not yet configured the FSP Smart Configurator in EWARM, see RZ/T2M, RZ/N2L, 
RZ/T2L Getting Started with Flexible Software Package (R01AN6434EJ). Section 5.4 explains 
how to set it up. 

 

Figure 6.18 Tools tab 
 

2. Code Generation Procedure 
After clicking "FSP Smart Configurator," check the following settings under the "BSP" tab on the screen 
that appears, and then click "Generate Project Content." The generated folder will be added. 

➢ RZ/T2M 
 CPU0 and CPU1 have the same settings. 

Board：:  RSK+RZT2M (RAM execution without flash memory) 
 

➢ RZ/N2L 
Board：:  RSK+RZN2L (RAM execution without flash memory) 
 

 
➢ RZ/T2L 

Board：:  RSK+RZT2L (RAM execution without flash memory) 
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Figure 6.19 FSP SC Smart Configurator 
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3. Build Procedure 

Click "Make" on the Project tab or click the button to build. When the build is complete, build messages 
will be displayed in the Build Console window, displaying the compilation target files and the number of 
errors/warnings. 

For RZ/T2M models, please start execution from CPU0. 
 

 
Figure 6.20 Make button 1 

 
 

 
 

Figure 6.21 Make button 2 and Build console 
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6.2.4 Downloading the application and running the debugger (single-core version) 
1. Click "Download and Debug" under "Project" on the menu bar, or click the Debug button to download 

the application program. After the debugger starts, the program will stop at the set breakpoint. 

For RZ/T2M, skip this section and proceed to” 6.2.5. Downloading the Application and Running the 
Debugger (Dual-Core Version)” 

 

 
Figure 6.22 Download and Debug button 

 
 

 
Figure 6.23 Debug button 
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2. Click the Go button. If the program is running correctly, it will wait for a TCP/IP connection request. 

Before running, please connect your PC as described in "7. Sample Application Demonstration." 
 

 
Figure 6.24 Break point and Go button 
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6.2.5 Downloading the application and running the debugger (Dual-Core Version)) 
Please perform the following steps. 

1. Close EWARM for the CPU1 project. 

2. Click "Download and Debug" in the "Project" menu bar, or click the Debug button to download the 
application program. After the debugger starts, the program will stop at the set breakpoint. 

 
 

 
Figure 6.25 Download and Debug button 

 
 

 
Figure 6.26 Debug button 
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3. As CPU0 downloads, CPU0 will become the master and the CPU1 project will automatically start as 
the slave, and both projects will stop at the set breakpoints. 

4. Click the Run button in the CPU0 project, then run the CPU1 project in the same way. 

Before running, connect via UART to a PC running terminal software. 
 
 

 
Figure 6.27 CPU0 Go button 

 
 
 

 
Figure 6.28 CPU1 Go button 
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7. Demonstration of the Sample Application 
The sample program demonstrates the echo server functionality and the LWIP add-ons "iperf" and "SNTP" in 
the "apps" folder, which can be run with a conditional compiler. 

 

7.1 Connecting to a PC 
Follow the steps below to connect the evaluation board to the communication PC. 

1. Connect the "USB to Serial Port" port shown in "4. Hardware Settings" to your PC using a USB cable. 

2. To display log data from the evaluation board, launch terminal software such as "Tera Term" using the 
following protocol. 

 

We will use "Tera Term" here. 
・ Port: Port added by connecting to the evaluation board 
・ Speed: 115200 
・ Other: DATA8 / NONE / 1 bit / Local Echo OFF 

3. Connect the Ethernet port shown in "4. Hardware Settings" to your PC's NIC using a LAN cable. 

 

 
 

Figure 7.1 Communication terminal connection 
 

 

  

Ethernet LAN cable 

USB to UART cable 
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7.2 Echo Server 
After running the sample application, the following screen will appear and the echo server will start, allowing 
you to send characters from your PC via telnet. 

Please send the following steps. 

 

 
Figure 7.2 Startup screen 

 

1. Open "Tera Term" on your PC. Set it up as shown below. 

 
Figure 7.3 Setting connection for Tera Term 

 

2. Enter any characters and press Enter. 

In the following screen capture, the characters you entered are returned by the board. 
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Figure 7.4 Demonstration 
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7.3 lwIP application. 
This sample program can run the following applications as lwIP add-ons. 
Please note that this function is available in sample program version 1.2 or later. 
 

As a demonstration, a working application. 
・  SNTP client function 
・ lwiperf (iperf2) server function 
・ lwiperf (iperf2) client function 
 
 
7.3.1 Steps to enable the application. 
Each application can be started by enabling conditional compilation, and the settings are shown below. 

1. Setting values for conditional compilation 
 

Application Setting values 
SNTP client Bit0=1: valid   integer：1 

   0: invalid   integer：0 
lwiperf (iperf2) server Bit1=1: valid   integer：2 

   0: invalid   integer：0 
lwiperf (iperf2) client Bit2=1: valid   integer：4 

   0: invalid   integer：0 
 

2. Settings at build time 

In each build environment, set the above setting values for the application you want to enable in the 
builder. 

 e2 studio 
Follow the steps below to set it up. 
In addition, when enabling multiple functions, please set with OR of each setting value. 
・ Project menu "Properties" → "C/C++ General" → "Paths and symbols" →

"_LWIP_ADD_ON_APP" select it and press the edit button on the right to set it. 
・ After setting, follow the procedure in Section 3 of “6.1.3” to build. 
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Figure 7.5 e2 studio 
 EWARM 

Follow the steps below to set it up. 
In addition, when enabling multiple functions, OR each setting value and set it. 

・ Project menu "Option" → "C/C++ Compiler" → "Preprocessor" → 
Set "_LWIP_ADD_ON_APP=5" directly in the symbol definition field. 

・ After setting, follow the procedure in Section 3 of “6.2.3” to build. 
 

Figure 7.6 EWARM 
 
3. Setting items required by the application 

The required settings for each application are listed below. 
Note that the IP addresses shown in red frames in Figure 7.7 and Figure 7.8 are setting examples, so be 
sure to set them according to your usage environment. 

 
Application Defined name Setting contents 
SNTP client SNTP_SERVER_IP 

Figure 7.7 
Figure 7.8 

IP address of the SNTP (NTP) 
server to connect to 

lwiperf (iperf2) server Use the "IP address" 
setting in 6.1.2 or 6.2.2 

iperf2(lwiperf) server IP address 

lwiperf (iperf2) client IPERF_SERVER_IP 
Figure 7.7 
Figure 7.8 

IP address of the iperf2 server to 
connect to 
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Figure 7.7 e2 studio 

 
 

 
Figure 7.8 EWARM 

 
4. Reference information about connection destinations for each application 

The table below shows the applications to which each application connects. 
Each application does not specify the connection destination application. 
 
Application Connection destination 

application 
how to get 

SNTP client Use Windows NTP 
server function 

Enable the normally disabled NTP 
server functionality with a registry 
change. 
The setting method is introduced on 
the website. 

lwiperf (iperf2) server "Iperf 2" is a free 
software for Windows. 

Please do a web search for "Iperf 2". 
Example of site 
https://sourceforge.net/projects/iperf2/ 

lwiperf (iperf2) client 

 
 
 
 

  

https://sourceforge.net/projects/iperf2/
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7.3.2 Execution steps for each application 
The applications set in 2 of “7.3 ” will start in the following order according to the steps in 6.1.4 or 6.2.4. Here 
are the steps: 

There is no difference in the procedure between e2 studio and EWARM. 
 
1. In the application startup order, the startup order decreases in the right direction. 

 SNTP client > lwiperf (iperf2) server > lwiperf (iperf2) client 

2. The steps to start each application are shown below. 

 SNTP client 
・ Before starting the sample program, start the NTP server on the connected Windows PC. 

・ After displaying the sample program startup LOG, the SNTP client function starts, displays the 
next LOG, and waits for a response from the NTP server. 

"<< SNTP client application start >>" 

・ It depends on the communication environment, but normally the notification time will be 
displayed as shown below after waiting for a response for about 5 seconds, and the process 
will end. 

"<< SNTP client application completed [ 09.08.2023 00:00:00 ] >>" 
・ If 150 seconds have passed while waiting for a response from the NTP server, the following 

LOG will be displayed and the process will end. 
"<< SNTP client application end with error >>" 

 
 lwiperf (iperf2) server 

・ After displaying the startup LOG of the sample program, if the lwiperf (iperf2) server function is 
enabled, the following LOG will be displayed, waiting for a connection from the lwiperf (iperf2) 
client. 
"<< IPERF2 server application start >>" 

・  After the above start LOG is displayed, start the lwiperf (iperf2) client from the connected 
Windows PC. 

・ Although it depends on the communication environment, it usually takes about 15 seconds 
after starting communication from the connection destination Windows PC, and the 
communication report is displayed as shown below and ends. 
"<< IPERF2 server application completed>>" 
"IPERF report: type=0, remote: 192.168.10.1:56861, total bytes: xxxxxxx, duration in ms: 
10000, kbits/s: xxxxx " 

・ If there is no connection from the lwiperf (iperf2) client within 180 seconds, the following LOG 
will be displayed and the process will end. 
" << IPERF2 server application end with error >>" 

 
 lwiperf (iperf2) client 

・ Before starting the sample program, start the iperf2 server on the connected Windows PC. 

・ After the sample program startup LOG is displayed, the lwiperf (iperf2) client function starts, 
the next LOG is displayed, and it waits for a response from the iperf2 server. 
"<< IPERF2 client application start >>" 

・ Depending on the communication environment, it usually takes about 15 seconds to display a 
communication report as shown below and finish. 
"<< IPERF2 client application completed >>" 
"IPERF report: type=1, remote: 192.168.10.1:5001, total bytes: xxxxxxx, duration in ms: 10000, 
kbits/s: xxxxx " 
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Figure 7.9 

Execution example with SNTP client, lwiperf (iperf2) server and lwiperf (iperf2) client enabled 
 
 
 

 
Figure 7.10  Execution example with lwiperf (iperf2) client enabled 

 
 
 
  



RZ/T2M, RZ/T2ME, RZ/N2L, RZ/T2L Group Quick Start Guide: lwIP Protocol Stack Sample Program 

r01an6560ej0150  Rev.1.50  Page 38 of 59 
Mar 20, 2026  

8. Software Specifications 
8.1 Software Structure 
An overview of the software is shown below. 

Legend in the figure: ( ) Destination of the corresponding source file 

 

 

Figure 8.1. Software Architecture Diagram 
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8.1.1 Components Overview 
Functionality overview in the overview diagram 

Table 8.1. Overview of Each Component 

Group Folder name Overview 
Applications common/renesas/application Demonstration App 

SRC Entry functions etc. 
API common/renesas/module/ether_netif Ethernet API 

common/renesas/module/lwip_port lwip API 
common/renesas/module/serial_io  

OS Rz*/aws/ freeRTOS 
driver rz*/fsp/ Ethernet driver 

rz*/fsp/ UART driver 
 

 

8.1.2 Drivers Used 
The stacks used in FSP are shown below. 

Table 8.2. Sample Software Support Status 

Stack Name function 
g_ioport I/O Port Driver Pin Settings, Control 
g_ether0 Ethernet Ethernet communication 
g_uart0 UART Serial communication 
Heap 4 Allocating heap for FreeRTOS 
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8.2 Task 
The task properties used in the sample program are shown below. 

Table 8.3. Task List 

Module Task 
name 

Priority Stack size 
[bytes] 

Synchronous mode Overview 

Main Main 
thread 

5 1024 Pause after initialization Main task 

Ethernet 
Port 

task_code 3 1024 Wake up every 1 
second 

Ethernet link status 
monitoring 

task_code 4 2048 Received events Waiting for received 
Ethernet data 

lwIP Port task_code 3 1024 Queue notification 
events 

LINK status notification 
processing 

lwIP lwIP 4 1024 Received events Reception processing 
within lwIP 

 

Table 8.4. RTOS Max Priority 

Item Value 
Max Priority 10 

 
 
8.2.1 Resources 
The resources used are shown below. 

Table 8.5. Used Resource 

Resources used  Format  Module Use 
Heap4 Heap memory All modules Ethernet transmission and 

reception data 
queue Queue Ethernet port Link status notification 
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8.2.2 Task Operations 
The following diagram shows the relationships between tasks. 

 

   Legend： 

         Driver internal processing       Task(thread)       

 

Figure 8.2. sequence   

Ether receive task 

Main thread 

Initialization and 
application execution 

Hibernate after completion 

g_ether0 Ethernet(r_gmac) 

Callback from ISR 

lwIP 

Ether Status 
monitoring task 

Ether state data 

Queued tasks 

Queue processing on 
state change 

Notify with registered 
callback 

Boot 
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8.2.3 Mirroring function for received packets 
This shows the function to notify additional modules of data received from the driver, similar to lwIP. 

1. Overview 

 
Legend： 

                 Added processing lwIP API 

 

Figure 8.3. sequence  

 

  

Ether receive task 

Registering notification 
callbacks for additional 
modules 

g_ether0 Ethernet(r_gmac) 

Callback from ISR 

lwIP 

Ether 

Status monitoring 
task 

Notify the registered callback function of the status and 
received data 

Boot Additional 
Modules 
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2. Interface 

To enable the mirroring feature, register a callback function with the lwIP API to receive received data 
(MAC frames). 

➤  Registering the Callback Function 
Sample source code is commented out in the lwIP function "um_lwip_port_ether_netif.c / 
um_lwip_port_ether_netif_open." 

 
➤  Notification Types 
・ ETHER_NETIF_CALLBACK_EVENT_LINK_UP 

Ethernet status: Notified when a link is established. No notification data. 

・ ETHER_NETIF_CALLBACK_EVENT_LINK_DOWN 
Ethernet status: Notified when a link is disconnected. No notification data. 

・ ETHER_NETIF_CALLBACK_EVENT_RECEIVE_ETHER_FRAME 
An Ethernet receive event notifies the received MAC frame (RAW) as a parameter. 

Note that the parameter buffer "p_frame_packet" must be freed after use. 
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8.2.4 Ethernet Sending API 
If you want to send MAC frames (RAW) directly without going through lwIP, a sample code is commented out 
in the source code below. 
 
The sample code is commented out in the lwIP function "um_lwip_port_mainf.c/115". 
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8.3 Memory Allocation 
The following three groups are placed in a project. 
・ Loader Program 
 Startup processing and initialization of the clock, interrupts, IO, etc. are placed in the BTCM. 

・ User Program 
Processing other than the loader program, such as the RTOS, interrupt vectors, drivers, and 
applications, is placed in the ATCM or system RAM. 

・ Shared Non-Cache 
Used as a storage location for Ethernet transmission and reception data, etc., this is placed in the mirror 
area of system RAM. 

 
 

8.3.1  e² studio project 
These definition files are located in the "script" folder. 

 xxxxxxxx.ld 
This is a link script file; the file name changes depending on the boot mode, etc. 

 xxxxxxxxx.h 
This is a physical memory definition file, and defines the address of the implemented device, etc. 
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1. RZ/T2M 

  The memory usage by group is shown below. 

➤ CPU0(CR52_0) 
The only application that runs on CPU0 is the LED blinking function. 

 
Figure 8.4. Memory footprint of the CPU0 project (e2 studio)  

Figure 8.5.  ATCM footprint of the CPU0 project (e2 studio) 

Figure 8.6.  BTCM footprint of the CPU0 project (e2 studio) 
  

RZT2M Memory Map

0x0000_0000
ATCM : 34.16 KB / 512.00 KB (6.67%)

0x0010_0000
BTCM : 28.57 KB / 128.00 KB (22.32%)

0x1000_0000
SYSTEM_RAM : 0 bytes / 2.00 MB (0.00%)

0x3000_0000
SYSTEM_RAM_MIRROR : 0 bytes / 2.00 MB (0.00%)

0x4000_0000
xSPI0_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x4800_0000
xSPI1_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x5000_0000
CS0,2,3,5_MIRROR : 0 bytes / 256.00 MB (0.00%)

0x6000_0000
xSPI0 (QSPI Flash) : 0 bytes / 128.00 MB (0.00%)

0x6800_0000
xSPI1 (Hyper RAM) : 0 bytes / 128.00 MB (0.00%)

0x7000_0000
CS0,2,3,5 : 0 bytes / 256.00 MB (0.00%)

ATCM
Total Usage : 34.16 KB

Start Address: 0x00000000 End Address: 0x0007FFFF

Section Name Start address Size Usage [%]
.intvec 0x00000000 128 bytes 0.02%
.text 0x00000100 484 bytes 0.09%
.ARM.exidx 0x000002E4 8 bytes 0.00%
.data 0x000002EC 1.54 KB 0.30%
.bss 0x00000918 16 bytes 0.00%
.heap 0x00000928 32.00 KB 6.25%

BTCM
Total Usage : 28.57 KB

Start Address: 0x00100000 End Address: 0x0011FFFF

Section Name Start address Size Usage [%]
.loader_text 0x00102000 4.16 KB 3.25%
.loader_data 0x001030A8 208 bytes 0.16%
.loader_bss 0x00103178 209 bytes 0.16%
.loader_stack 0x00103250 24.00 KB 18.75%
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➤ CPU1(CR52_1) 
The application running on CPU1 will perform functions other than blinking the LED. 

 

 
Figure 8.7. Memory footprint of the CPU1 project (e2 studio)  

Figure 8.8.  SYSTEM_RAM footprint of the CPU1 project (e2 studio) 

Figure 8.9.  SYSTEM_RAM (MIRROR) footprint of the CPU1 project (e2 studio) 
 
 
  

RZT2M Memory Map

0x0000_0000
ATCM : 0 bytes / 512.00 KB (0.00%)

0x0010_0000
BTCM : 0 bytes / 128.00 KB (0.00%)

0x1000_0000
SYSTEM_RAM : 474.28 KB / 2.00 MB (23.16%)

0x3000_0000
SYSTEM_RAM_MIRROR : 24.25 KB / 2.00 MB (1.18%)

0x4000_0000
xSPI0_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x4800_0000
xSPI1_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x5000_0000
CS0,2,3,5_MIRROR : 0 bytes / 256.00 MB (0.00%)

0x6000_0000
xSPI0 (QSPI Flash) : 0 bytes / 128.00 MB (0.00%)

0x6800_0000
xSPI1 (Hyper RAM) : 0 bytes / 128.00 MB (0.00%)

0x7000_0000
CS0,2,3,5 : 0 bytes / 256.00 MB (0.00%)

SYSTEM_RAM
Total Usage : 474.28 KB

Start Address: 0x10000000 End Address: 0x101FFFFF

Section Name Start address Size Usage [%]
.intvec 0x10000000 128 bytes 0.01%
.loader_text 0x10001000 3.14 KB 0.15%
.loader_data 0x10001C90 208 bytes 0.01%
.loader_bss 0x10001D60 2.09 KB 0.10%
.loader_stack 0x100025C0 24.00 KB 1.17%
.text 0x10010000 85.34 KB 4.17%
.ARM.exidx 0x10025558 8 bytes 0.00%
.data 0x10025560 4.30 KB 0.21%
.bss 0x10026698 322.08 KB 15.73%
.heap 0x10076EE8 32.00 KB 1.56%
.thread_stack 0x1007EEE8 1.00 KB 0.05%

SYSTEM_RAM_MIRROR
Total Usage : 24.25 KB

Start Address: 0x30000000 End Address: 0x301FFFFF

Section Name Start address Size Usage [%]
.noncache 0x30180000 24.25 KB 1.18%
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2. RZ/N2L 

In the case of RZ/N2L, the size of the ATCM is small, so the user program is placed in SYSTEM_RAM. 

 

Figure 8.10. Memory footprint of the CPU0 project (e2 studio)  

Figure 8.11.  ATCM footprint of the CPU0 project (e2 studio) 

Figure 8.12.  BTCM footprint of the CPU0 project (e2 studio) 
 
 
  

ATCM
Total Usage : 128 bytes

Start Address: 0x00000000 End Address: 0x0001FFFF

Section Name Start address Size Usage [%]
.intvec 0x00000000 128 bytes 0.10%

RZN2L Memory Map

0x0000_0000
ATCM : 128 bytes / 128.00 KB (0.10%)

0x0010_0000
BTCM : 12.42 KB / 128.00 KB (9.71%)

0x1000_0000
SYSTEM_RAM : 440.41 KB / 1.50 MB (28.67%)

0x3000_0000
SYSTEM_RAM_MIRROR : 24.25 KB / 1.50 MB (1.58%)

0x4000_0000
xSPI0_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x4800_0000
xSPI1_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x5000_0000
CS0,2,3,5_MIRROR : 0 bytes / 256.00 MB (0.00%)

0x6000_0000
xSPI0 (QSPI Flash) : 0 bytes / 128.00 MB (0.00%)

0x6800_0000
xSPI1 : 0 bytes / 128.00 MB (0.00%)

0x7000_0000
CS0,2,3,5 : 0 bytes / 256.00 MB (0.00%)

BTCM
Total Usage : 12.42 KB

Start Address: 0x00100000 End Address: 0x0011FFFF

Section Name Start address Size Usage [%]
.loader_text 0x00102000 4.13 KB 3.23%
.loader_data 0x00103088 208 bytes 0.16%
.loader_bss 0x00103158 2.09 KB 1.63%
.loader_stack 0x001039B8 6.00 KB 4.69%
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Figure 8.13.  SYSTEM_RAM footprint of the CPU0 project (e2 studio) 
 

Figure 8.14.  SYSTEM_RAM (MIRROR) footprint of the CPU0 project (e2 studio) 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
 
  

SYSTEM_RAM
Total Usage : 440.41 KB

Start Address: 0x10000000 End Address: 0x1017FFFF

Section Name Start address Size Usage [%]
.text 0x10001000 99.16 KB 6.46%
.ARM.exidx 0x10019CA8 8 bytes 0.00%
.data 0x10019CB0 9.04 KB 0.59%
.bss 0x1001C0D8 323.20 KB 21.04%
.heap 0x1006CDA8 8.00 KB 0.52%
.thread_stack 0x1006EDA8 1.00 KB 0.07%

SYSTEM_RAM_MIRROR
Total Usage : 24.25 KB

Start Address: 0x30000000 End Address: 0x3017FFFF

Section Name Start address Size Usage [%]
.noncache 0x30100000 24.25 KB 1.58%
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3. RZ/T2L 

  The memory usage by group is shown below. 

 

Figure 8.15. Memory footprint of the CPU0 project (e2 studio)  

Figure 8.16.  ATCM footprint of the CPU0 project (e2 studio) 

Figure 8.17.  BTCM footprint of the CPU0 project (e2 studio) 
 
 
  

RZT2L Memory Map

0x0000_0000
ATCM : 443.36 KB / 512.00 KB (86.59%)

0x0010_0000
BTCM : 30.47 KB / 128.00 KB (23.80%)

0x1000_0000
SYSTEM_RAM : 0 bytes / 1.00 MB (0.00%)

0x3000_0000
SYSTEM_RAM_MIRROR : 24.23 KB / 1.00 MB (2.37%)

0x4000_0000
xSPI0_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x4800_0000
xSPI1_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x5000_0000
CS0,2,3,5_MIRROR : 0 bytes / 256.00 MB (0.00%)

0x6000_0000
xSPI0 (Hyper RAM) : 0 bytes / 128.00 MB (0.00%)

0x6800_0000
xSPI1 (QSPI Flash) : 0 bytes / 128.00 MB (0.00%)

0x7000_0000
CS0,2,3,5 : 0 bytes / 256.00 MB (0.00%)

ATCM
Total Usage : 443.36 KB

Start Address: 0x00000000 End Address: 0x0007FFFF

Section Name Start address Size Usage [%]
.intvec 0x00000000 128 bytes 0.02%
.text 0x00000100 83.09 KB 16.23%
.ARM.exidx 0x00014D60 8 bytes 0.00%
.data 0x00014D68 5.14 KB 1.00%
.bss 0x000161F8 321.99 KB 62.89%
.heap 0x000669F0 32.00 KB 6.25%
.thread_stack 0x0006E9F0 1.00 KB 0.20%

BTCM
Total Usage : 30.47 KB

Start Address: 0x00100000 End Address: 0x0011FFFF

Section Name Start address Size Usage [%]
.loader_text 0x00102000 4.18 KB 3.27%
.loader_data 0x001030B8 208 bytes 0.16%
.loader_bss 0x00103188 2.09 KB 1.63%
.loader_stack 0x001039E8 24.00 KB 18.75%
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Figure 8.18.  SYSTEM_RAM (MIRROR) footprint of the CPU0 project (e2 studio) 
 
 
  

SYSTEM_RAM_MIRROR
Total Usage : 24.23 KB

Start Address: 0x30000000 End Address: 0x300FFFFF

Section Name Start address Size Usage [%]
.noncache 0x30080000 24.23 KB 2.37%
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8.3.2 EWARM project 
It is placed in the definition file below in the "script" folder. 
➤  xxxxxxxx.icf 
 This is a link script file. The file name changes depending on the boot mode, etc. 
➤ xxxxxxxxx.h 
 This is the physical memory definition file, and defines the addresses of the implemented devices. 
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1. RZ/T2M 
The memory usage by group is shown below. 

➤ CPU0(CR52_0) 

The only application running on CPU0 is the LED blinking function. 

 

 
Figure 8.19. Memory footprint of the CPU0 project (EWARM) 

 Figure 8.20.  ATCM footprint of the CPU0 project (EWARM) 
 

Figure 8.21.  BTCM footprint of the CPU0 project (EWARM) 
  

RZT2M Memory Map

0x0000_0000
ATCM : 34.31 KB / 512.00 KB (6.70%)

0x0010_0000
BTCM : 28.56 KB / 128.00 KB (22.31%)

0x1000_0000
SYSTEM_RAM : 4 bytes / 2.00 MB (0.00%)

0x3000_0000
SYSTEM_RAM_MIRROR : 0 bytes / 2.00 MB (0.00%)

0x4000_0000
xSPI0_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x4800_0000
xSPI1_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x5000_0000
CS0,2,3,5_MIRROR : 0 bytes / 256.00 MB (0.00%)

0x6000_0000
xSPI0 (QSPI Flash) : 0 bytes / 128.00 MB (0.00%)

0x6800_0000
xSPI1 (Hyper RAM) : 0 bytes / 128.00 MB (0.00%)

0x7000_0000
CS0,2,3,5 : 0 bytes / 256.00 MB (0.00%)

ATCM
Total Usage : 34.31 KB

Start Address: 0x00000000 End Address: 0x0007FFFF

Section Name Start address Size Usage [%]
VECTOR_RBLOCK 0x00000000 136 bytes 0.03%
USER_PRG_RBLOCK 0x00000100 562 bytes 0.11%
.rodata 0x00000334 1.47 KB 0.29%
.version 0x00000914 56 bytes 0.01%
.rodata 0x0000094C 76 bytes 0.01%
.version 0x00000998 12 bytes 0.00%
HEAP_BLOCK 0x000009A8 32.00 KB 6.25%
USER_DATA_ZBLOCK 0x000089A8 12 bytes 0.00%
ATCM_END_block 0x000089B4 4 bytes 0.00%

SYSTEM_RAM
Total Usage : 4 bytes

Start Address: 0x10000000 End Address: 0x101FFFFF

Section Name Start address Size Usage [%]
NONCACHE_END_block 0x10180000 4 bytes 0.00%
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➤ CPU1(CR52_1) 
The application running on CPU1 will perform functions other than blinking the LED. 

 

Figure 8.22. Memory footprint of the CPU1 project (EWARM)  
 

Figure 8.23.  SYSTEM_RAM footprint of the CPU1 project (EWARM) 
 

Figure 8.24.  SYSTM_RAM (MIRROR) footprint of the CPU1 project (EWARM) 
 
 
  

RZT2M Memory Map

0x0000_0000
ATCM : 0 bytes / 512.00 KB (0.00%)

0x0010_0000
BTCM : 0 bytes / 128.00 KB (0.00%)

0x1000_0000
SYSTEM_RAM : 474.28 KB / 2.00 MB (23.16%)

0x3000_0000
SYSTEM_RAM_MIRROR : 24.25 KB / 2.00 MB (1.18%)

0x4000_0000
xSPI0_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x4800_0000
xSPI1_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x5000_0000
CS0,2,3,5_MIRROR : 0 bytes / 256.00 MB (0.00%)

0x6000_0000
xSPI0 (QSPI Flash) : 0 bytes / 128.00 MB (0.00%)

0x6800_0000
xSPI1 (Hyper RAM) : 0 bytes / 128.00 MB (0.00%)

0x7000_0000
CS0,2,3,5 : 0 bytes / 256.00 MB (0.00%)

SYSTEM_RAM
Total Usage : 474.28 KB

Start Address: 0x10000000 End Address: 0x101FFFFF

Section Name Start address Size Usage [%]
.intvec 0x10000000 128 bytes 0.01%
.loader_text 0x10001000 3.14 KB 0.15%
.loader_data 0x10001C90 208 bytes 0.01%
.loader_bss 0x10001D60 2.09 KB 0.10%
.loader_stack 0x100025C0 24.00 KB 1.17%
.text 0x10010000 85.34 KB 4.17%
.ARM.exidx 0x10025558 8 bytes 0.00%
.data 0x10025560 4.30 KB 0.21%
.bss 0x10026698 322.08 KB 15.73%
.heap 0x10076EE8 32.00 KB 1.56%
.thread_stack 0x1007EEE8 1.00 KB 0.05%

SYSTEM_RAM_MIRROR
Total Usage : 24.25 KB

Start Address: 0x30000000 End Address: 0x301FFFFF

Section Name Start address Size Usage [%]
.noncache 0x30180000 24.25 KB 1.18%
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2. RZ/N2L 
In the case of RZ/N2L, the size of the ATCM is small, so the user program is placed in SYSTEM_RAM. 

 

 

Figure 8.25. Memory footprint of the CPU0 project (EWARM)  

Figure 8.26.  ATCM footprint of the CPU0 project (EWARM) 

Figure 8.27.  BTCM footprint of the CPU0 project (EWARM) 

Figure 8.28.  SYSTEM_RAM footprint of the CPU0 project (EWARM) 
 
  

ATCM
Total Usage : 128 bytes

Start Address: 0x00000000 End Address: 0x0001FFFF

Section Name Start address Size Usage [%]
.intvec 0x00000000 128 bytes 0.10%

RZN2L Memory Map

0x0000_0000
ATCM : 136 bytes / 128.00 KB (0.10%)

0x0010_0000
BTCM : 12.64 KB / 128.00 KB (9.87%)

0x1000_0000
SYSTEM_RAM : 449.93 KB / 1.50 MB (29.29%)

0x3000_0000
SYSTEM_RAM_MIRROR : 0 bytes / 1.50 MB (0.00%)

0x4000_0000
xSPI0_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x4800_0000
xSPI1_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x5000_0000
CS0,2,3,5_MIRROR : 0 bytes / 256.00 MB (0.00%)

0x6000_0000
xSPI0 (QSPI Flash) : 0 bytes / 128.00 MB (0.00%)

0x6800_0000
xSPI1 : 0 bytes / 128.00 MB (0.00%)

0x7000_0000
CS0,2,3,5 : 0 bytes / 256.00 MB (0.00%)

ATCM
Total Usage : 136 bytes

Start Address: 0x00000000 End Address: 0x0001FFFF

Section Name Start address Size Usage [%]
VECTOR_RBLOCK 0x00000000 136 bytes 0.10%

BTCM
Total Usage : 12.64 KB

Start Address: 0x00100000 End Address: 0x0011FFFF

Section Name Start address Size Usage [%]
LDR_PRG_RBLOCK 0x00102000 4.36 KB 3.41%
LDR_DATA_WBLOCK 0x00103178 204 bytes 0.16%
LOADER_STACK 0x00103248 6.00 KB 4.69%
LDR_DATA_ZBLOCK 0x00104A48 2.08 KB 1.62%
SOFTWARE_RESET_ZBLOCK 0x00105295 1 bytes 0.00%
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3. RZ/T2L 
 The memory usage by group is shown below. 
 

 
Figure 8.29. Memory footprint of the CPU0 project (EWARM) 

 
Figure 8.30.  ATCM footprint of the CPU0 project (EWARM) 

  

ATCM
Total Usage : 446.28 KB

Start Address: 0x00000000 End Address: 0x0007FFFF

Section Name Start address Size Usage [%]
VECTOR_RBLOCK 0x00000000 136 bytes 0.03%
USER_PRG_RBLOCK 0x00000100 86.02 KB 16.80%
.rodata 0x00015918 2.29 KB 0.45%
USER_DATA_WBLOCK 0x00016240 476 bytes 0.09%
.rodata 0x0001641C 1.01 KB 0.20%
.version 0x00016824 56 bytes 0.01%
.rodata 0x0001685C 1.48 KB 0.29%
.version 0x00016E4C 8 bytes 0.00%
.rodata 0x00016E54 32 bytes 0.01%
.version 0x00016E74 4 bytes 0.00%
.rodata 0x00016E78 7 bytes 0.00%
USER_DATA_ZBLOCK 0x00016E80 321.78 KB 62.85%
HEAP_BLOCK 0x000675A0 32.00 KB 6.25%
THREAD_STACK 0x0006F5A0 1.00 KB 0.20%

RZT2L Memory Map

0x0000_0000
ATCM : 446.28 KB / 512.00 KB (87.16%)

0x0010_0000
BTCM : 30.56 KB / 128.00 KB (23.88%)

0x1000_0000
SYSTEM_RAM : 24.23 KB / 1.00 MB (2.37%)

0x3000_0000
SYSTEM_RAM_MIRROR : 0 bytes / 1.00 MB (0.00%)

0x4000_0000
xSPI0_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x4800_0000
xSPI1_MIRROR : 0 bytes / 128.00 MB (0.00%)

0x5000_0000
CS0,2,3,5_MIRROR : 0 bytes / 256.00 MB (0.00%)

0x6000_0000
xSPI0 (Hyper RAM) : 0 bytes / 128.00 MB (0.00%)

0x6800_0000
xSPI1 (QSPI Flash) : 0 bytes / 128.00 MB (0.00%)

0x7000_0000
CS0,2,3,5 : 0 bytes / 256.00 MB (0.00%)
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Figure 8.31.  BTCM footprint of the CPU0 project (EWARM) 
 

 
Figure 8.32.  SYSTEM_RAM footprint of the CPU0 project (EWARM) 

 
  

BTCM
Total Usage : 30.56 KB

Start Address: 0x00100000 End Address: 0x0011FFFF

Section Name Start address Size Usage [%]
LDR_PRG_RBLOCK 0x00102000 4.29 KB 3.35%
LDR_DATA_WBLOCK 0x00103128 204 bytes 0.16%
LOADER_STACK 0x001031F8 24.00 KB 18.75%
LDR_DATA_ZBLOCK 0x001091F8 2.08 KB 1.62%
SOFTWARE_RESET_ZBLOCK 0x00109A45 1 bytes 0.00%

SYSTEM_RAM
Total Usage : 24.23 KB

Start Address: 0x10000000 End Address: 0x100FFFFF

Section Name Start address Size Usage [%]
NONCACHE_ZBLOCK 0x10080000 24.23 KB 2.37%
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8.4 CPU Utilization 
This shows the CPU Utilization (task operation rate) of each device. 
Please note that the measurements were performed using a simplified calculation method with the 
FreeRTOS API in e² studio, and therefore should be considered as reference values only. 
 

1. RZ/T2M 
・iperf communication in progress 

CPU Utilization 72％ 
・When the echo server is waiting for a client 

CPU Utilization 18％ 
 
 

2. RZ/N2L 
・iperf communication in progress 

CPU Utilization 74％ 
・When the echo server is waiting for a client 

CPU Utilization 35％ 
 

3. RZ/T2L 
・iperf communication in progress 
 CPU Utilization 65％ 
・When the echo server is waiting for a client 
 CPU Utilization 26％ 
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General Precautions in the Handling of Microprocessing Unit and Microcontroller 
Unit Products 
The following usage notes are applicable to all Microprocessing unit and Microcontroller unit products from Renesas. For detailed usage notes on the 
products covered by this document, refer to the relevant sections of the document as well as any technical updates that have been issued for the products. 

1. Precaution against Electrostatic Discharge (ESD) 

A strong electrical field, when exposed to a CMOS device, can cause destruction of the gate oxide and ultimately degrade the device operation. Steps 

must be taken to stop the generation of static electricity as much as possible, and quickly dissipate it when it occurs. Environmental control must be 

adequate. When it is dry, a humidifier should be used. This is recommended to avoid using insulators that can easily build up static electricity. 

Semiconductor devices must be stored and transported in an anti-static container, static shielding bag or conductive material. All test and 

measurement tools including work benches and floors must be grounded. The operator must also be grounded using a wrist strap. Semiconductor 

devices must not be touched with bare hands. Similar precautions must be taken for printed circuit boards with mounted semiconductor devices. 
2. Processing at power-on 

The state of the product is undefined at the time when power is supplied. The states of internal circuits in the LSI are indeterminate and the states of 

register settings and pins are undefined at the time when power is supplied. In a finished product where the reset signal is applied to the external reset 

pin, the states of pins are not guaranteed from the time when power is supplied until the reset process is completed. In a similar way, the states of pins 

in a product that is reset by an on-chip power-on reset function are not guaranteed from the time when power is supplied until the power reaches the 

level at which resetting is specified. 
3. Input of signal during power-off state 

Do not input signals or an I/O pull-up power supply while the device is powered off. The current injection that results from input of such a signal or I/O 

pull-up power supply may cause malfunction and the abnormal current that passes in the device at this time may cause degradation of internal 

elements. Follow the guideline for input signal during power-off state as described in your product documentation. 
4. Handling of unused pins 

Handle unused pins in accordance with the directions given under handling of unused pins in the manual. The input pins of CMOS products are 

generally in the high-impedance state. In operation with an unused pin in the open-circuit state, extra electromagnetic noise is induced in the vicinity of 

the LSI, an associated shoot-through current flows internally, and malfunctions occur due to the false recognition of the pin state as an input signal 

become possible. 
5. Clock signals 

After applying a reset, only release the reset line after the operating clock signal becomes stable. When switching the clock signal during program 

execution, wait until the target clock signal is stabilized. When the clock signal is generated with an external resonator or from an external oscillator 

during a reset, ensure that the reset line is only released after full stabilization of the clock signal. Additionally, when switching to a clock signal 

produced with an external resonator or by an external oscillator while program execution is in progress, wait until the target clock signal is stable. 
6. Voltage application waveform at input pin 

Waveform distortion due to input noise or a reflected wave may cause malfunction. If the input of the CMOS device stays in the area between VIL 

(Max.) and VIH (Min.) due to noise, for example, the device may malfunction. Take care to prevent chattering noise from entering the device when the 

input level is fixed, and also in the transition period when the input level passes through the area between VIL (Max.) and VIH (Min.). 
7. Prohibition of access to reserved addresses 

Access to reserved addresses is prohibited. The reserved addresses are provided for possible future expansion of functions. Do not access these 

addresses as the correct operation of the LSI is not guaranteed. 
8. Differences between products 

Before changing from one product to another, for example to a product with a different part number, confirm that the change will not lead to problems. 

The characteristics of a microprocessing unit or microcontroller unit products in the same group but having a different part number might differ in terms 

of internal memory capacity, layout pattern, and other factors, which can affect the ranges of electrical characteristics, such as characteristic values, 

operating margins, immunity to noise, and amount of radiated noise. When changing to a product with a different part number, implement a system-

evaluation test for the given product. 
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Notice 
1. Descriptions of circuits, software and other related information in this document are provided only to illustrate the operation of semiconductor products 

and application examples. You are fully responsible for the incorporation or any other use of the circuits, software, and information in the design of your 
product or system. Renesas Electronics disclaims any and all liability for any losses and damages incurred by you or third parties arising from the use 
of these circuits, software, or information. 

2. Renesas Electronics hereby expressly disclaims any warranties against and liability for infringement or any other claims involving patents, copyrights, 
or other intellectual property rights of third parties, by or arising from the use of Renesas Electronics products or technical information described in this 
document, including but not limited to, the product data, drawings, charts, programs, algorithms, and application examples. 

3. No license, express, implied or otherwise, is granted hereby under any patents, copyrights or other intellectual property rights of Renesas Electronics 
or others. 

4. You shall be responsible for determining what licenses are required from any third parties, and obtaining such licenses for the lawful import, export, 
manufacture, sales, utilization, distribution or other disposal of any products incorporating Renesas Electronics products, if required. 

5. You shall not alter, modify, copy, or reverse engineer any Renesas Electronics product, whether in whole or in part. Renesas Electronics disclaims any 
and all liability for any losses or damages incurred by you or third parties arising from such alteration, modification, copying or reverse engineering. 

6. Renesas Electronics products are classified according to the following two quality grades: “Standard” and “High Quality”. The intended applications for 
each Renesas Electronics product depends on the product’s quality grade, as indicated below. 
 "Standard": Computers; office equipment; communications equipment; test and measurement equipment; audio and visual equipment; home 

electronic appliances; machine tools; personal electronic equipment; industrial robots; etc. 
 "High Quality": Transportation equipment (automobiles, trains, ships, etc.); traffic control (traffic lights); large-scale communication equipment; key 

financial terminal systems; safety control equipment; etc. 
Unless expressly designated as a high reliability product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas 
Electronics document, Renesas Electronics products are not intended or authorized for use in products or systems that may pose a direct threat to 
human life or bodily injury (artificial life support devices or systems; surgical implantations; etc.), or may cause serious property damage (space 
system; undersea repeaters; nuclear power control systems; aircraft control systems; key plant systems; military equipment; etc.). Renesas Electronics 
disclaims any and all liability for any damages or losses incurred by you or any third parties arising from the use of any Renesas Electronics product 
that is inconsistent with any Renesas Electronics data sheet, user’s manual or other Renesas Electronics document. 

7. No semiconductor product is absolutely secure. Notwithstanding any security measures or features that may be implemented in Renesas Electronics 
hardware or software products, Renesas Electronics shall have absolutely no liability arising out of any vulnerability or security breach, including but 
not limited to any unauthorized access to or use of a Renesas Electronics product or a system that uses a Renesas Electronics product. RENESAS 
ELECTRONICS DOES NOT WARRANT OR GUARANTEE THAT RENESAS ELECTRONICS PRODUCTS, OR ANY SYSTEMS CREATED USING 
RENESAS ELECTRONICS PRODUCTS WILL BE INVULNERABLE OR FREE FROM CORRUPTION, ATTACK, VIRUSES, INTERFERENCE, 
HACKING, DATA LOSS OR THEFT, OR OTHER SECURITY INTRUSION (“Vulnerability Issues”). RENESAS ELECTRONICS DISCLAIMS ANY AND 
ALL RESPONSIBILITY OR LIABILITY ARISING FROM OR RELATED TO ANY VULNERABILITY ISSUES. FURTHERMORE, TO THE EXTENT 
PERMITTED BY APPLICABLE LAW, RENESAS ELECTRONICS DISCLAIMS ANY AND ALL WARRANTIES, EXPRESS OR IMPLIED, WITH 
RESPECT TO THIS DOCUMENT AND ANY RELATED OR ACCOMPANYING SOFTWARE OR HARDWARE, INCLUDING BUT NOT LIMITED TO 
THE IMPLIED WARRANTIES OF MERCHANTABILITY, OR FITNESS FOR A PARTICULAR PURPOSE. 

8. When using Renesas Electronics products, refer to the latest product information (data sheets, user’s manuals, application notes, “General Notes for 
Handling and Using Semiconductor Devices” in the reliability handbook, etc.), and ensure that usage conditions are within the ranges specified by 
Renesas Electronics with respect to maximum ratings, operating power supply voltage range, heat dissipation characteristics, installation, etc. Renesas 
Electronics disclaims any and all liability for any malfunctions, failure or accident arising out of the use of Renesas Electronics products outside of such 
specified ranges. 

9. Although Renesas Electronics endeavors to improve the quality and reliability of Renesas Electronics products, semiconductor products have specific 
characteristics, such as the occurrence of failure at a certain rate and malfunctions under certain use conditions. Unless designated as a high reliability 
product or a product for harsh environments in a Renesas Electronics data sheet or other Renesas Electronics document, Renesas Electronics 
products are not subject to radiation resistance design. You are responsible for implementing safety measures to guard against the possibility of bodily 
injury, injury or damage caused by fire, and/or danger to the public in the event of a failure or malfunction of Renesas Electronics products, such as 
safety design for hardware and software, including but not limited to redundancy, fire control and malfunction prevention, appropriate treatment for 
aging degradation or any other appropriate measures. Because the evaluation of microcomputer software alone is very difficult and impractical, you are 
responsible for evaluating the safety of the final products or systems manufactured by you. 

10. Please contact a Renesas Electronics sales office for details as to environmental matters such as the environmental compatibility of each Renesas 
Electronics product. You are responsible for carefully and sufficiently investigating applicable laws and regulations that regulate the inclusion or use of 
controlled substances, including without limitation, the EU RoHS Directive, and using Renesas Electronics products in compliance with all these 
applicable laws and regulations. Renesas Electronics disclaims any and all liability for damages or losses occurring as a result of your noncompliance 
with applicable laws and regulations. 

11. Renesas Electronics products and technologies shall not be used for or incorporated into any products or systems whose manufacture, use, or sale is 
prohibited under any applicable domestic or foreign laws or regulations. You shall comply with any applicable export control laws and regulations 
promulgated and administered by the governments of any countries asserting jurisdiction over the parties or transactions. 

12. It is the responsibility of the buyer or distributor of Renesas Electronics products, or any other party who distributes, disposes of, or otherwise sells or 
transfers the product to a third party, to notify such third party in advance of the contents and conditions set forth in this document. 

13. This document shall not be reprinted, reproduced or duplicated in any form, in whole or in part, without prior written consent of Renesas Electronics. 
14. Please contact a Renesas Electronics sales office if you have any questions regarding the information contained in this document or Renesas 

Electronics products. 

(Note1) “Renesas Electronics” as used in this document means Renesas Electronics Corporation and also includes its directly or indirectly controlled 
subsidiaries. 

(Note2) “Renesas Electronics product(s)” means any product developed or manufactured by or for Renesas Electronics.  
(Rev.5.0-1  October 2020) 

 
Corporate Headquarters  Contact information 

TOYOSU FORESIA, 3-2-24 Toyosu, 
Koto-ku, Tokyo 135-0061, Japan 
www.renesas.com 

 For further information on a product, technology, the most up-to-date 
version of a document, or your nearest sales office, please visit: 
www.renesas.com/contact/. 

Trademarks   
Renesas and the Renesas logo are trademarks of Renesas Electronics 
Corporation. All trademarks and registered trademarks are the property 
of their respective owners. 
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